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Arrangement of the Dissertation 

Each dissertation must be arranged in the following order. Specific information about each section is on 

the following pages. Italicized pages are optional. 

 Title page 

 Copyright page 

 Abstract 

 Acknowledgment page 

 Preface 

 List of Abbreviations 

 Glossary 

 Nomenclature 

 Dedication 

 Table of Contents 

 List of Tables, Illustrations, Figures, or Graphs 

 Introduction 

 Text body 

 Tables, Illustrations, Figures, Graphs1 

 References 

 Appendices 

 Vita 

  

                                                            
1 If not incorporated into the main body of the text, these items should immediately follow the text. They should 
not be placed at the end of chapters. 
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Formatting and Layout Requirements 

Page Size 

 The page size should be 8.5 x 11”, standard US Letter size (not A4). 

Margins 

 There should be one inch margins on all sides, including page numbers. 

 Page numbers should conform to margin requirements and be placed at least 1” from the top and 

right sides of the page, as appears in this document. A tutorial for page number placement appears 

later in this document. 

Spacing 

 The preliminary pages (abstract, dedication, acknowledgements, table of contents) and main body 

text must be double spaced. 

 Quotations, captions, items in tables, lists, graphs and charts may be single spaced. 

Pagination 

 Every page in a dissertation is numbered, except the title page. 

 Page numbering will begin on the second page with Arabic numeral 2. 

 There should be no blank pages. 

 On pages of the dissertation that are formatted with landscape orientation, the page number must 

appear in lower right-hand corner if the page, so that it would appear in the correct location if the 

page were rotated to portrait orientation. A landscape page tutorial appears later in this document. 

Fonts 

 Any legible font is permitted except script, italic, or ornamental fonts. Fonts must be embedded. 

 Font size should be equivalent in scale to 10pt. Arial or 12pt. Times New Roman. 

Foreign Language Dissertations 

 A student in a foreign language department who writes the dissertation in a language other than 

English is required to write a 10-20 page summary of the dissertation in English and include it as 

an appendix. 

 The abstract of a foreign language dissertation must be in English. 
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Dissertation Content Requirements 

Title Page 

 

The title page should conform to the sample below.  See also the title page of this document.  

 

 
 

 Dissertation Title2 

o The title of the dissertation should be in mixed case; the first and last words and all nouns, 

pronouns, adjectives, verbs, and adverbs are capitalized. Articles (a, an, the), coordinating 

conjunctions (and, but, or, for, nor), and prepositions, regardless of length, are lowercased unless 

they are the first or last word of the title or subtitle. Only acronyms should be set in full capitals. 

o Special characters cannot be used in titles. Use word substitutes in place of formulas, symbols, 

superscripts, or Greek letters. 

 Academic Field 

o The academic field designated on the title page must be selected from the official list provided by 

The Graduate School. 

 Date 

o There is no comma between the month and year. This date should correspond to the expected 

month of degree conferral. 

                                                            
2 For dissertation title best practices, see Appendix A. 

http://www.tgs.northwestern.edu/academics/programs/index.html
http://www.tgs.northwestern.edu/academics/programs/index.html
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Copyright Page  

 

 If you choose to copyright your manuscript, a copyright notice must appear on a separate 

page following the title page. It should read as follows:  

 

© Copyright by (your name) 20__ 

All Rights Reserved 

 

For more information about copyrighting your dissertation, please see the information on the TGS 

website. 

 

Abstract 

  

 Inclusion of the abstract within the preliminary pages of the dissertation is required.  

 Mathematical formulas, photographs, diagrams, and other illustrative materials are not 

recommended for inclusion in the abstract.  

 

Optional Prefatory Pages 

 

 Acknowledgment page  

 Preface  

 List of abbreviations  

 Glossary  

 Nomenclature  

 Dedication  

 

Table of Contents  

 

 The format of the table of contents should conform to the guidelines in an approved style manual.  

 It is important that the table of contents accurately reflect the outline and organization of the 

manuscript.  

 

Lists of Tables, Illustrations, Figures, or Graphs 

 

 These lists should reproduce the specific titles and page locations of all illustrative materials.  

 

Body of the Text 

 

 Chapters should follow a logical outline, with a clear distinction between chapters, main heads 

within chapters, and subordinate heads within the main heads.  

 The outline and organization of the main body of the text should be accurately reflected in the 

table of contents.  

 All non-textual elements (e.g., tables, graphs, and images) must be described in the text.  

http://www.tgs.northwestern.edu/academics/degree-requirements/dissertation-publication.html
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Tables, Illustrations, Figures, Graphs 

 

 If not incorporated into the main body of the text, these items should immediately follow the text, 

not at the end of chapters.  

 Margin requirements must be met on all pages that contain charts, graphs, tables, or illustrations.  

  

References  

 

 Each dissertation must include references to document the text.  

 These references may be included at the bottom of the page or at the end of the text, but cannot be 

placed at the end of each chapter.  

 The format for references must conform to the guidelines in an approved style manual.  

 

Appendices (optional)  

 

 The format for the appendices must conform to the guidelines in an approved style manual.  

 

Vita (optional)  

 

 It is recommended that each copy of the dissertation include a brief vita containing the author’s 

name, place of birth, education, relevant professional experience, and publications. The vita page 

is numbered. 

 

Supplementary Materials (optional) 

 

If supplementary materials—such as audio, video, and spreadsheets—are part of your dissertation or 

thesis, you can submit them as supplementary files during the online submission process. See Appendix B 

for additional details. 

 Do not embed media files in your PDF. 

 Upload media files as supplementary files. During online submission, you will be asked to upload 

any supplementary files. 

 Describe files in your abstract. Add a description of each supplementary file in your abstract.  
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Guides and How-To’s 

 This section will provide tutorials on some of the most common dissertation formatting problems. 

The vast majority of these tutorials have to do with page numbers, which are the single most common 

error that comes up in dissertation reviews. After reading these tutorials, you will be able to format your 

page numbers to start and stop in the right places, respect the margin requirements, and appear in the 

proper place on landscape pages3. 

How to Number Your Pages Correctly 

 As you may recall from Chapter 1, every page in the dissertation should have a page number, 

with the exception of the title page. The numbering should begin on the second page with “2”. The easiest 

way to make sure the title page is not numbered, while ensuring that every other page is numbered, is by 

changing the header settings. In order to do this, click into the header so that the “Header & Footer Tools” 

menu appears. Then, make sure the “Different First Page” option is selected. Now you can delete the page 

number from the title page while still leaving page numbers on the rest of the page.

 

Figure 1 - Header and Footer Tools menu with "Different First Page" option selected. 

 The single most common formatting error that appears in NU dissertations is the placement of 

page numbers. Page numbers need to be placed in the upper right-hand corner of the page, and they need 

to conform to margin requirements. These margin requirements are important because of ProQuest’s 

archiving process; when dissertations are archived, the pages are cropped, and if text, figures, or page 

                                                            
3 Unfortunately, these tutorials are designed to help with dissertations written in Microsoft Word. If you are using 
LaTeX, these guides will be of no use. Of course, if you are using LaTeX, you probably aren’t having these problems 
to begin with. 
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numbers are placed too close to the edge of the page, they run the risk of being cut off. Assuming your 

margin settings are correct, Microsoft Word should automatically place page numbers one inch from the 

right side of the page; it’s the requirement that they be placed one inch from the top of the page that 

causes problems, as the default header setting puts only a half-inch margin between the page number and 

the top of the page. 

 The solution to this problem can be found in the “Header and Footer Tools” menu. Once the 

menu is open, set the “Header from Top” distance to one inch. This setting adjustment will ensure that 

any text in the header, including page numbers, is placed one inch from the top of the page4.

 

Figure 2 - Header and Footer Tools menu, with "Header from Top" set to one inch. 

 In some cases, you might want to insert a landscape page into your thesis in order to 

accommodate a table or figure. The important thing to remember is that the page numbers on landscape 

pages need to be placed so that they will appear in the upper right-hand corner of the page if the page 

were rotated to portrait orientation. The following tutorial will show you how to include a landscape 

page and properly position page numbers.

                                                            
4 If you change your header settings after setting up your Table of Contents, you will probably want to double-
check that the Table of Contents and any other numbered lists (List of Figures or List of Tables) are still accurate, as 
changing the distance of the header from the top of the page can throw off the numbering. 



 
 

 

Figure 3 – Page Layout menu with “Next Page” section break selected; Drawing Tools menu with “Rotate all text 90°” selected under the “Text Direction” heading. 

9
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In order to insert a landscape page into a document with portrait orientation, you will need to start 

a new section. In order to do this, use the “Page Breaks” tool within the Page Layout menu, and select the 

type of section break labelled “Next Page,” as seen in Figure 3. Once you have created the new section, 

select the new page and change the orientation (also in the Page Layout menu) to landscape. 

To add a page number to your landscape page, insert a text box by going to the Insert menu and 

selecting “Text Box.” Now, reposition your text box so that it appears in the lower right-hand corner of 

the page. Make sure that your text box is positioned one inch from the edges of the page. You can then 

type in the appropriate page number. In order to get the number to face the correct direction, click into the 

text box and select the Drawing Tools menu. From there, select the “Text Direction” sub-menu and 

choose the “Rotate all text 90°” option, as seen in Figure 3. Your page number should now be facing the 

appropriate direction. In order to put the remaining pages back into landscape format, add another section 

break and change the page orientation back to “Portrait.” You may have to add the page numbers back 

into the header in this section, in which case you should double-check that your page numbers are still 

positioned properly. 
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Appendix A – Dissertation Title Best Practices 
 

Dissertations are a valuable resource for other scholars only if they can be easily located. Modern retrieval 

systems generally use the words in the title to locate a document.  It is essential that the title be an accurate and 

meaningful description of the content and that obscure references be avoided.  Please use these guidelines 

when formulating a dissertation title: 
 

 CASE:  The first and last words and all nouns, pronouns, adjectives, verbs, and adverbs (if, because, 

as, that, etc.) are capitalized.  Articles (a, an, the), coordinating conjunctions (and, but, or, for, nor), 

and prepositions, regardless of length, are lowercased unless they are the first or last word of the title 

or subtitle. Only acronyms should be set in full capitals. 

Examples:   

Power and Consumer Behavior 

Outpatient Treatment for Children:  Organizational Practices as Predictors of Recovery 

A Comparison of the Methodologies for Determining Achievement in High School 
 

 HYPHENATION:  Consult the dictionary as to whether a word is hyphenated.  In general, do not 

hyphenate words beginning with the prefixes co, non, pre, post, or re unless there is a possibility of 

confusion (co-op, post-master's) or the root word begins with a capital letter (post-Renaissance). 

Hyphenate words beginning with the prefix self. Hyphenate compounds used as adjectives (decision-

making) but not as nouns (decision maker). Part-time is always hyphenated. When more than one 

prefix is joined to a base word, hyphenate the prefixes standing alone (micro- and macroeconomics). 

Do not hyphenate fundraising, freelance, yearlong, health care, African American, Asian American. 

Examples:   

Great Nonfiction Works of the Nineteenth Century (Instead of: Great Non-fiction Works of 

the 19th Century) 
 

 SPELLING AND GRAMMAR:  Dissertation titles should be spell-checked and dictionary spelling 

of words should be used.  Use “and” rather than “&,” and spell out names of centuries and other 

numbers usually spelled out in text. 

Example:   

The Labour Party in Perspective and Twelve Years Later 
 

 SPECIAL CHARACTERS:  No special characters should appear in the dissertation title 

(SES/CAESAR cannot accommodate special characters).  Terms or phrases that include special 

characters should instead be written out. 

Examples:   

Evaluation of DNA Hybridization and Cleavage Capabilities of Peptide Nucleic Acid-

Titanium Dioxide (instead of: Evaluation of DNA Hybridization and Cleavage Capabilities of 

PNA-TiO2) 

The Role of TGF-beta Variants in Cancer (instead of: The Role of TGF-β Variants in Cancer) 
 

 ITALICIZATION:  Italics should only be used in dissertation titles when referring to the title of a 

published work, foreign language words, gene names, scientific names as appropriate, or other words 

that are usually italicized. 

Examples:   

Techniques in Drosophila Circadian Biology 

Mechanisms of Differentiated Cell Function in vitro 
 

 APOSTROPHES:  Do not use to form plurals (it should be 1940s, not 1940's) unless it would be 

confusing without (thus A's and B's, not As and Bs; p's, not ps).  Possessives of singular nouns ending 

in s are formed by adding 's (e.g., Russ's dog). 
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Appendix B – File Format Recommendations for Supplemental Files 

 

Software applications used to open files and their specifications tend to become harder to find over time, and 

some formats will be difficult or impossible to read in the future. The file formats with the best chance of 

survival have open specifications, are high quality, and are in relatively wide use. Ensuring these formats can 

be accessed or read in the future is key to their long-term preservation. 

 

Please follow these recommendations when making format choices for all content that is part of your 

dissertation submission. Also, make sure the format is an uncompressed version, highest quality compressed 

version, or the final production version. This will help maximize potential for long term preservation and 

accessibility. 

 

Unfortunately, it's not possible to provide a single list of file formats that are appropriate for all use cases, but 

this list is a good starting point. Also, please exercise caution when using proprietary formats and digital rights 

management (DRM) software that may make viewing content difficult or impossible to access in the future. If 

you have any questions, please contact the University Libraries at library@northwestern.edu. Your question 

will be routed to staff with the appropriate staff to help you. 

  

Simplified Guidelines/File Format Recommendations (for more detailed specifications, see the Library’s 

scholarly communication libguide.) 

 

 Audio — Highly recommended: AIFF (.aif, .aiff) or WAV (.wav) . Moderately recommended: 

MP3 (.mp3), AAC (.mp4, .mp4a, .aac), FLAC (.flac) or ALAC (.m4a). 

 Video — Highly recommended: Uncompressed Quicktime Movie (.mov); uncompressed AVI 

(.avi). Moderately recommended: MPEG-1, MPEG-2 or MPEG-4 encoded video (.avi, .mpg, .mpeg, 

.mov, .mkv, .mp4). 

 Virtual Reality/3D — Highly recommended: X3D (*.x3d). Please talk with a Northwestern Digital 

Librarian to determine best output settings and format. 

 Image - Highly recommended: Full color images @ 600dpi or higher saved as JPEG2000 

Lossless (.jp2) or TIFF 24-bit, uncompressed (.tif, .tiff). Moderately recommended: lossy 

compressed formats limited to JPEG (.jpg, .jpeg), JPEG2000 (.jp2), TIFF (.tif, .tiff), or PNG (.png) at 

highest quality possible. 

 Text - Highly recommended: Open Document Text (.odt), UTF-8 Unicode text (.txt), or PDF/A 

(.pdf). Moderately recommended: Rich Text Format (.rtf). 

 Presentation - Highly recommended: Open Document Presentation (.odp). Moderately 

recommended: PDF/A (.pdf) for images only. 

 Spreadsheet - Highly recommended: Open Document Spreadsheet (.ods). Moderately 

recommended: Comma separated value CSV (.csv) or Tab-delimited text file (.txt). 

 

http://libguides.northwestern.edu/scholcomm
http://libguides.northwestern.edu/scholcomm

